Trimble R10 VRS Survey to ArcGIS Import

Devloped by Scott Ralston – USFWS Windom Wetland Management District

Last Updated May 2020
Available for download at: http://skralston.com/USFWS/
This tutorial is for use with a Trimble TSC7 controller running Trimble Access Software version 2020.00
and Trimble R10 GPS Receiver and VRS style differential correction. ArcGIS version 10x is the desktop
computer software used here. Other models and versions may be similar but be aware you may need to
make adjustments for differences. TSC10 would be very similar but all touch screen and no keyboard.
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1. Setting up and turning on the equipment
a. Order of operations is important to reduce errors.
b. Turn on the R10 GPS and attach it to the survey pole or other mounting bracket you are
using.
i. The antenna in the case that screws to the bottom of the R10 is NOT used for VRS
type surveys. It is only used if you use a RTK base station which is not covered here.
ii. The controller doesn’t have to be directly next to the receiver but should be within
about 100ft. Thus you can have an assistant operating the survey rod with the GPS
while you run the controller if needed.

c. Turn on the mifi jetpack or other wifi hotspot device. For hotspot sharing from an iphone go
into settings – Personal Hotspot and “Allow Others to Join” turned on and must remain on
this screen until the device connects. May have to go back to this screen to reconnect if
disconnected by going in to sleep mode.
i. Make sure it has cell a signal.
ii. If low signal or no signal you may be able to extend the range with an external
antenna or change positions to higher ground.
iii. The jetpack has a range of up to 1,000ft in clear areas so it can be placed in a central
high point for your survey if you do not get sufficient signal carrying it with you.
iv. Any error messages relating to the “base” is a problem with your internet
connection.
d. Turn on the controller by pressing the green button. From full power off may need to press
and hold for 1 second.
i. This controller is essentially a windows computer running on Windows 10.
Sometimes errors can be solved by a full power off and on reboot choosing
shutdown from the start menu instead of just sleep mode by quickly pressing the
power button.
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ii. At the Welcome or log on screen just press enter to continue. No log on needed.
e. Connect to the internet
i. If the controller has been used with your hotspot before it will probably connect
itself once powered on. Remember if using iphones the screen needs to be opened
to the Personal Hotspot settings screen to connect.
ii. If you have a problem in later steps with connecting to internet tap the up arrow on
the taskbar down by the clock and the network settings. If it is connected it will have
the wifi bars and if not will have the globe icon which you can tap that to see
available networks and connect to one.

f.

Notice the Bluetooth icon is also in this location if you have issues connecting to the R10 and
need Bluetooth settings.
g. Right Click on a touch screen is press and hold.
h. Note Touch modes. From the task bar you can open touch screen modes with the blue
finger icon. Stylus mode works with both stylus and finger so use this most often. Finger
only works with a finger touch not the stylus. Glove is more sensitive to bigger touches.

i.

If you need more control you can also plug in a mouse to the USB port. We have a wireless
trackball mouse in the case, plug the USB receiver key into the TSC7 and flip the power
button on the mouse to on to use.
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2. Starting a new Trimble access job
a. This tutorial assumes you already have the basic settings on your controller set up. If you are
starting fresh, consult your Trimble dealer or other experienced user for initial GPS settings.
b. Open Trimble Access from either the icon on the desktop, the taskbar or from the start
menu.

c. For our unit we only have 1 project file for all our jobs called “Windom” so in this case just
hit Open.
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d. If you are opening an existing file just scroll through the list and select it or filter by typing all
or part of the job name in the Filter box. Select and hit Open.

e. If you are creating a new job file hit the New Button
i. Give it a name
ii. Choose a template which most jobs in our case just use the “shapefile” template
which is set to use WGS84 Zone 15 North as the coordinate system, feet as the
height units and meters as the grid coordinate units and Geoid 12A for the Geoid
model. This is appropriate for most shapefiles we deal with in our jobs. If you are
importing or exporting shapefiles in a UTM coordinate system your Distance Units
MUST be in Meters.
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iii. If the template doesn’t work for the needs of your job you can edit any as needed
manually choosing coordinate system and select from library.
iv. To overlay a shapfile or other map element on your screen hit ‘Active Map
v. If you need to load your shapefile from another computer, export it from GIS in a
appropriate UTM coordinate system that matches what you will use on the GPS like
WGS84 Zone 15. Copy the shapefile including it’s multiple file parts to a USB flash
drive, plug into the USB port on the bottom of the unit and copy and paste the
shapefiles into the shortcut folder on the TSC7 desktop or the My Documents folder
as long as you can brows to the location.
vi. Scroll down through the list of files and tap to check them and include them in the
map.

vii. Press Accept to create the new job
viii. Note on WMS Web Map services available. In the Active map list we already have
MN WMS loaded but if not hit the WMS button and enter their address. Then in the
Active map list under MNGeo.wms you will have the option for streaming air photos
or topographic hillshade. These can be handy is some scenarios but may slow the
drawing speed of the map so don’t use unless you need the photo reference.
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ix. After hitting accept on the active map and Enter on the Create new job screen the
job will open in map mode.
x. Use the zoom and pan buttons on the left to navigate
xi. Two batteries on the TSC7 status is displayed at the top along with the battery
status of the R10 once it is connected. R10 should have auto connected via
Bluetooth if it was on when the TSC7 was turned on and Access was opened.

f. To start the survey GPS hit Measure
g. A screen with a list of Mount points will appear. Unless otherwise specified use
CMRx_NAD83 (2011). Highlight it and hit Accept.

7

h. You could get a warning about calibration. Ignore if you don’t need specific features like
compensated point for tilted survey rods. Otherwise can take the time to calibrate using the
built in directions that will walk you through it. You will need a leveled surface to reference.
i. Once initiated the accuracy displays in the top right.
j. If you want to see your current position readings such as real time elevation hit the menu
button in the top left go down to Instrument and Position

k. Navigating on screen after you hit measure to get the differential GPS engaged, just follow
the cross hairs for your location. Zoom in or out or pan as needed. Staking or locating
features like dike or wetland shapefiles just line up edges with the crosshairs. Zoom in to
under 5m scale to be more accurate. To turn on or off various layers in your map hit the
layers button which is the bottom button on the left side with 2 squares staked.
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l.

To take a point see the measure points sidebar that pops up when you hit measure or hit F2
or hit the measure points button.
i. The field names we have are specific to the Windom setup so other devices may
have other field names. To customize field names for your project settings go to the
top right menu, Settings, Templates, Edit the template, Tap on Additional Settings
and change the description labels there
ii. Enter a Point name which is generally easiest to just start with 1 as whatever you
enter here will automatically count up sequentially with the next point. If you put a
letter then a number like T1 it will count up T1, T2, T3…
iii. Codes you can use if you want a shortcut for common item descriptions instead of
typing them. To set up codes go to Menu, Stettings, Feature Libraries, Select and
edit your library or create a new one, then enter Short names and descriptive
names. However when exporting final data to a shapefile only the short name will
transfer.
iv. Notes type any information about what you are surveying
v. Description if only if you need more room than the notes area
vi. Method – Use Rapid point for most quick shots. It just takes a single fast reading,
Topo point you need to hold on a position and it will average about 7 readings for
more accuracy on important features, compensated point can be used with the R10
if the calibration settings are correct and it will compensate the recorded position
for a tilted survey rod like leaning the rod in to get an inside shot of a culvert pipe.
For the most part don’t use the other points. Continuous topo mode will be cover in
another section below for grid mapping on a mobile platform like a UTV. (Any of
these survey method settings can be changed in Menu, Settings, Survey styles, VRS
and edit each option as needed such as making the topo point more or less than 7
readings averaged or setting accuracy tolerance.)
vii. Make sure the Antenna height is correct for whatever survey rod you are using.
Standard survey rod fully extended and locked in is 2 meters or 6.562 feet
viii. Hit measure when ready to take the point or enter on the keypad.
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ix. You will hear a sound or voice command “Observation Stored”
3. Continuous Topo – For taking a lot of ground shots quickly such as gridding an area you should use
the continuous topo mode with the GPS mounted on an ATV.
a. Follow the steps in the previous section for getting connected and GPS initialized
b. Press the Menu button in the top left corner and go to Measure and Continuous Topo.
Similar to the measure points there are places to put in various field info. Choose how you
want it to record such as a shot on a set time interval or a distance traveled such as a shot
every 1 meter. If you are on an ATV be sure to set the appropriate antenna height. Start and
stop the topo survey with the blue button in the bottom right corner. Drive slow to keep
more accurate under 10mph.

4. Creating a line from points. You may use this to create a line running between points such as to
mark a boundary line from 2 corner benchmarks.
a. First capture the two start and end points for your line with one of the methods above using
rapid point or topo point depending on your accuracy needs.
b. From the top left menu button go to Key in and Lines
c. Give the line a name and any notes, choose your method and enter the name of the start
and end points. Then Hit Calc and the line will appear on the map. You can then visually
navigate with the pan and zoom tools along that line.
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5. Reviewing a point
a. From the top left menu button under job data hit Point manager. Scroll down to the point
you want to review and tap the arrow next to it to expand the data for that point.

6. Working in low cell coverage
a. The R10 relies on real time correction information to retain accuracy. The older the
correction information the less accurate it will be thus needs a constant wifi source to
update it’s corrections. However if it temporarily loses signal it can utilize the last know
correction for a few minutes.
b. If you need to get a shot in a low spot or something where cell signal can’t reach, first try
putting your hotspot up high where it can get a signal as often the wifi signal can travel up
to 1,000ft in open air and still reach the TSC7. The Wifi signal needs to reach the TSC7 not
the R10 so if the TSC7 can be held higher and another person operates the Survey rod with
the R10 lower a couple hundred feet away can further cover distance.
c. If that doesn’t work you can move to an area with signal and initialize the GPS. Then move
to the survey location out of signal quickly and take the shot. The GPS will tell you it is using
xFill and will show that in the status bar. but the accuracy will diminish the longer it goes so
within about 5-10 minutes will be out of range for most acceptable topo surveys.

d. Trees or other canopy cover scatters and fragments the GPS signal so xFill only works with
the wifi and can not help a weak GPS fix. For poor GPS reception the best you can do is
extent the survey rod length if you have extensions to get the receiver higher and adjust the
antenna height. Otherwise use rapid point measurement mode and hit measure and hold
still and sometimes a position fix will happen for a very short moment or watch the accuracy
display for when it gets reasonably low and hit enter again to capture the point anyway
even if it was out of range. Just note that position may have error.
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7. Export the survey job as a shapefile to use in GIS
a. From the Top left menu back out to the job screen

b. Highlight the job you want to export data from and hit the export button at the bottom
c. Choose format ESRI shapefile, give a file name and Grid style coordinates. Note when you
import to AcrGIS the coordinate system is not defined in the export so define the coordinate
system you used in ArcMap. In most of our files we are using WGS84 Zone 15N.

8. Finishing Survey – When done with your survey it is best to close out everything. From the top left
menu button scroll to the bottom and hit Exit. It will ask if you want to power down the receiver so
hit Yes. or if it doesn’t automatically then hold the power button on the R10 until it turns off. Then
shut down the TSC7. Pressing the green power button puts it in sleep mode but still slowly uses
battery. From the windows start menu choose shutdown to turn the power completely off.
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9. Other settings
a. Coordinate system settings from Select from Library options in job settings
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b. RTK Setup in Menu, Settings, Survey Styles and Edit Survey Style:
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10. Import data to desktop computer
a. Check where the export was saved but generally in the Documents folder on the TSC7. Open
windows Explorer. It is standard Windows so select the files you want, hit Copy, Put in a
flash drive to the USB port and paste the files on to the flash drive.
b. On your desktop computer plug in the flash drive and copy and paste the files into your
project folder.

11. Importing Survey Shapefiles in ArcGIS
a. Open ArcMap
b. Click on the ArcCatalog button. White square with yellow file cabinet icon on top toolbar.
c. Navigate to where your survey shapefile is stored. If you don’t see your disk drive hit the
connect to folder button (folder icon with a + sign), Highlight your drive you want to add and
hit OK and it will add a shortcut to that drive in your Catalog window
d. Once you see your shapefile in the list right click on it and choose properties
e. Define the coordinate system
i. When it is exported from trimble, for some reason they do not export the
coordinate system which is needed for proper use of shapefiles.
ii. In the properties window go to the XY Coordinate System Tab and define your
Coordinate System in the list
iii. For common UTM WGS84 Zone 15N it is under Projected-UTM- WGS 1984
f. Rename the shapefile if you want to something intuitive like Jobname_Survey_points.shp
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g. Add the shapefile to your map by either dragging and dropping or use the add data button
h. Open the attribute table and notice what has been imported. It should have your point
name, notes or descriptions and the Lat, Long and elevations. If you used code values then
only the code is imported but not the code definition.
i. Notice the first point in the list is something like PRS###. This is the VRS base station used
for GPS corrections. I recommend starting editing and deleting this point so it does not
confuse later steps.

12. Creating a 3d terrain surface from your survey.
a. If your survey is complete enough coverage to represent topography of the area it will be
easier to view as a continuous surface instead of a series of points. You can then also create
contour liens and in later steps design restoration features like dikes and spillways.
b. If all your points are ground shots you can continue as is. If some points are not ground
elevation such as water surface, top of culverts etc., you may want to exclude those from
your 3d surface since those points don’t actually represent your terrain.
i. Select all points that will make up your terrain surface
ii. Right click on the layer in the table of contents
iii. Under Selection, choose “Create Layer from Selected Features”
iv. You now have a subset layer from those selected points
c. Open ArcToolbox – Red toolbox icon on the top menu bar
d. Open 3D Analyst Tools > Data Management > TIN > Create TIN
e. Output TIN is what you want to name it and where to save it. Use something intuitive like
“Survey3d”
f. Define the Coordinate system which should be the same as the input data
g. Input data is your survey points layer which you can drag and drop from the table of
contents, choose from the dropdown menu or browse to the file
h. Change both height field and tab field to Elevation
i. Hit OK
j. You now have a 3d layer of your survey
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k. You can change the display color ramp if needed by double clicking on the layer or right click
and choose properties and go to the symbology tab. I recommend sticking with the default
color ramp but increase the number of classes to the maximum of 32.

13. Supplementing Survey data with LIDAR
a. Often LIDAR data is good for general landscape features but survey data fills in gaps with
more accurate information such as wetland bottoms in heavy vegetation where LIDAR is not
as good. You can combine datasets to get a good full picture.
b. See the supplemental tutorial for working Using LIDAR to Design Embankments in ArcGIS for
more information about LIDAR.
c. From the LIDAR tutorial (steps 1, 2 & 3) obtain LIDAR data, clip it to the work area and
convert units to feet (assuming your survey is also in feet elevation units)
d. You should now have a clipped lidar Raster/DEM layer in feet units
e. Open ArcToolbox and go to Conversion Tools > From Raster > Raster to Point
f. Input Raster is your clipped lidar
g. Field by default should be the elevation values of the raster
h. Output point features is where you want to store it and what you want to name it.
Something intuitive like Lidar_points.shp
i. Hit ok
j. Now you have a point layer with a elevation point every square meter from the lidar
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k.
l.
m.
n.

Next we will remove the LIDAR points where we have quality survey data
From the file menu at the top of the screen go to Selection and select by location
Use select features from and choose the Lidar_points layer you created
Source layer is the survey points layer (or sub-selection layer of survey points representing
ground shots)
o. Spatial Selection method is by default “intersect the source layer feature”
p. Check the box for apply a search distance. Choose a distance that you feel comfortable
where the survey point at that location will override the lidar data such as 10ft.
q. Hit OK and now all lidar points within that buffer distance of the survey points will be
selected.

r.

However we actually want the inverse selected so right click on the lidar_points layer in the
table of contents and go to selection the “switch selection” and the selection will now
reverse
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s. Create a new layer from the selection by right clicking again on the lidar points layer in the
table of contents, go down to selection, hit Create Layer from Selected features

t.

Rename this new layer if needed in the table of contents such as LIDAR Buffer

u. Now you can again create a 3d Terrain model as outlined in section 13 above. However in
step 13g include both the survey point data AND the LIDAR buffer point data in the input. Be
sure to again change the height field and tag field to the elevation values. Name it
something intuitive like Survey_Lidar_Merge3d
v. You will now have a 3d terrain surface that merges the survey data with the LIDAR data to
fill in survey gaps.
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w. Contour lines can be made from the new TIN layer, Open ArcToolbox, go to 3D Analysis
Tools > Terrain and TIN Surface > Surface Contour
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x. This merged TIN layer can be supplemented and used in the dike building tutorial instead of
pure LIDAR data. In the dike building exercise you need a TIN in Meters units so add a step
of creating a new field in the attribute table for both the lidar points layer as well as the
survey points layer and do a conversion calculation to meters. Then continue with the rest
of the steps to create the TIN with the meters as the height and tag value field.
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Repeat for Elevation values in GPS Survey Points

Refer to the Diking Building Tutorial for more information on designing dikes in ArcGIS from digital
elevation data. If you have gotten to this step of making a hybrid Survey and Lidar TIN layer you will
resume on step 7 of the Dike building tutorial.
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